HELP DOCUMENT

ON

APFD-GEOPORTAL
## Table of Contents

<table>
<thead>
<tr>
<th>Sr.No.</th>
<th>Topic</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Getting Started</td>
<td>4</td>
</tr>
<tr>
<td>2.</td>
<td>Main Screen</td>
<td>4</td>
</tr>
<tr>
<td>3.</td>
<td>Home Tab</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.1 Project Tree</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>3.2 Feature Layer</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>3.3 Raster Layer</td>
<td>7</td>
</tr>
<tr>
<td>4.</td>
<td>Analysis Tab</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4.1 Horizontal Distance Tool</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>4.2 Aerial Distance Tool</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>4.3 Vertical Distance Tool</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>4.4 Terrain Area Tool</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>4.5 3D Plane Area Tool</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>4.6 Contour Map Tool</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>4.7 Slope Map Tool</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>4.8 Flood Analysis Tool</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>4.9 Volume Analysis Tool</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>4.10 Terrain Profile Tool</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>4.11 Best Path Tool</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>4.12 Slope Query Tool</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>4.13 Line of Sight Tool</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>4.14 3D Viewshed Tool</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>4.15 Viewshed Analysis Tool</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>4.16 Threat Dome Tool</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>4.17 Selection Shadow Tool</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>4.18 Imagery Comparison Tool</td>
<td>32</td>
</tr>
<tr>
<td>5.</td>
<td>Draw Tab</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5.1 Select Tool</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>5.2 Delete Tool</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>5.3 Marker Tool</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>5.4 Drawing Tool</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>5.5 Urban Design</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>5.6 Create Text Label</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>5.7 Create Image Label</td>
<td>39</td>
</tr>
<tr>
<td>Section</td>
<td>Feature</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>5.8</td>
<td>Create Polyline</td>
<td>40</td>
</tr>
<tr>
<td>5.9</td>
<td>Create Polygon</td>
<td>41</td>
</tr>
<tr>
<td>5.10</td>
<td>Create 2D Shape</td>
<td>42</td>
</tr>
<tr>
<td>5.11</td>
<td>Create Building &amp; Load 3D Model</td>
<td>43</td>
</tr>
<tr>
<td>5.12</td>
<td>Create 3D Shape</td>
<td>47</td>
</tr>
<tr>
<td>6.</td>
<td>Navigation Tab</td>
<td></td>
</tr>
<tr>
<td>6.1</td>
<td>Navigate in Drag Mode</td>
<td>49</td>
</tr>
<tr>
<td>6.2</td>
<td>Navigate in Slide Mode</td>
<td>49</td>
</tr>
<tr>
<td>6.3</td>
<td>Navigate in Turn &amp; Tilt Mode</td>
<td>49</td>
</tr>
<tr>
<td>6.4</td>
<td>3D Mode</td>
<td>49</td>
</tr>
<tr>
<td>6.5</td>
<td>GPS Tracking</td>
<td>50</td>
</tr>
<tr>
<td>6.6</td>
<td>Target</td>
<td>51</td>
</tr>
<tr>
<td>6.7</td>
<td>Multiple Co-ordinate Systems Tool</td>
<td>52</td>
</tr>
<tr>
<td>6.8</td>
<td>Look Around Tool</td>
<td>52</td>
</tr>
<tr>
<td>7.</td>
<td>View Tab</td>
<td></td>
</tr>
<tr>
<td>7.1</td>
<td>Layout</td>
<td>53</td>
</tr>
<tr>
<td>7.2</td>
<td>Hide Terrain</td>
<td>53</td>
</tr>
<tr>
<td>7.3</td>
<td>Units</td>
<td>53</td>
</tr>
<tr>
<td>7.4</td>
<td>Screen Overlays</td>
<td>54</td>
</tr>
<tr>
<td>7.5</td>
<td>Field of View</td>
<td>57</td>
</tr>
<tr>
<td>7.6</td>
<td>Environmental Effects</td>
<td>58</td>
</tr>
</tbody>
</table>
1. GETTING STARTED :
1.1 Open Internet Explorer (version 8.0 or higher) or Google Chrome.
1.2 Browse to APFDGIS.com.

1.3 Click on SkylineGlobe link on APFDGIS.com homepage. APFD Geoportal page will be displayed.

1.4 Click on Setup link to download the setup file.
1.5 Run the setup.exe on local machine.
1.6 Browse to APFD Geoportal page and click on Geoportal link. You can now view the 3D application.
2. **MAIN SCREEN:**

This section describes the main screen of APFD-Geoportal Application:

- **3D Window:**
  
  In this window, you view the terrain and overlaid content in 3D.

- **Project Tree:**
  
  Contains a list of all the items in the project organized in a tree structure.

- **Ribbon Tool:**
  
  TerraExplorer Ribbon organizes all commands in logical groups, which are collected together under tabs. Each tab relates to a type of activity, such as navigating in the map or working with objects.
3. **HOME TAB:**

The Home tab contains standard commands for project management.

![Home Tab](image)

### 3.1 Project Tree:

The Project Tree provides quick access to a list of elements in the project that can be arranged into groups, according to type of information or location.

### 3.2 Feature Layer:

To load a feature file:

1. If you want to add a layer to the Project Tree root, in the Add group, click Feature Layer.

2. If you want to add a layer to a group, select the group and then in the Add group, click the arrow next to Feature Layer and select the required file type.

The Browse for Feature Layer dialog box opens.

![Feature Layer Dialog Box](image)
3. Browse to the required file and click Open.

4. Set the layer’s General Settings and click Next.

![General Settings Dialog Box.](image)

5. Layer settings dialog box is displayed. Select the attributes you want to display.
6. Under Annotation tab select **Text Label** as **Symbol Type**. In the **Text** Field select the **Attribute** to be displayed as Text. Click on **Import** button.

![Layer Settings Dialog Box.](image)

![Field by Attribute Dialog Box.](image)
3.3 Raster Layer:

To load a raster layer:

1. In the Home Tab, click on Raster Layer.
2. Click on Select Imagery Layer from file and browse for the imagery layer on local machine.
3. Click on open button to add imagery layer.
4. **ANALYSIS TAB:**

The Analysis tab contains commands for performing measurements and terrain analysis.

4.1 **Horizontal Distance Tool:**

The Horizontal Distance tool allows you to measure the horizontal distance between two or more points.

To use the horizontal distance tool:

1. On the Analysis tab, in the Measure group, click **Horizontal**.

2. In the 3D Window, click any point on the terrain or on an object to define the start point of the measurement. A yellow line extends from the start point.

3. Drag the cursor to the next point and click again.

4. Repeat step 3 to add as many segments as required.

5. Right-click to finish the measurement.

6. If you want to obtain measurements between any two or more points in the terrain, with the Horizontal Distance tool selected, repeat steps 2-5 above.

7. If you want to close this tool, on the Analysis tab, in the Measure group, click **Horizontal**.
4.2 Aerial Distance Tool:

The Aerial Distance tool allows you to measure the aerial distance, elevation difference and slope between two or more points.

To use the Aerial Distance tool:

1. On the Analysis tab, in the Measure group, click Aerial.

2. In the 3D Window, click any point in the terrain or on an object to define the start point of the measurement. A yellow line extends from the start point.

3. Drag the cursor to the next point and click again.

4. Repeat step 3 to add as many segments as required.

5. Right-click to finish the measurement.

6. If you want to obtain measurements between any two or more points in the terrain, with the Aerial Distance tool selected, repeat steps 2-5 above.

7. If you want to close this tool, on the Analysis tab, in the Measure group, click Aerial.
4.3 **Vertical Distance Tool:**

The Vertical Difference tool allows you to measure the vertical difference between two points by selecting the first point and dragging the ruler up to the desired position.

To use the Vertical Difference tool:

1. On the Analysis tab, in the Measure group, click Vertical.

2. In the 3D Window, click any point in the terrain or on an object to define the start point of the measurement. A yellow line extends from the start point.

3. Drag the cursor to the next point and click again.

4. If you want to obtain measurements between any two or more points in the terrain, with the Vertical Distance tool selected, repeat steps 2-3 above.

5. If you want to close this tool, on the Analysis tab, in the Measure group, click Vertical.
4.4 Terrain Area Tool:

Using the Terrain Area tool, you can measure the following for a defined area on the terrain:

- **Area of the horizontal projection** (2D measurement) - The area measured is the horizontal projection of the area you have outlined, even if some or all of your selected area encompasses mountainous terrain.
- **Surface area** (3D measurement) - The area measured takes into account terrain contours.

To use the Terrain Area tool:

1. On the Analysis tab, in the Measure group, click Terrain Area.
2. In the 3D Window, click any point on the terrain to define the start point of the measurement.
3. Drag the cursor to the next point in the required area and click again.
4. Repeat step 3 as many times as necessary to set the required area for measurement. A minimum of three points must be selected.
5. Right-click to finish the measurement. The Terrain Area Measurement dialog box is displayed.
6. If you want to calculate the horizontal projection of the area you have outlined, select Horizontal plane. The area and perimeter of the horizontal projection are immediately displayed in the open dialog box.
7. If you want to calculate the surface area of the selected region taking into account terrain contours, do the following:
   a. Select Terrain surface.
   b. In the Sample interval field, type the desired distance between terrain sample points.
   c. Click Calculate. The area and perimeter of the selected region taking into account terrain contours are calculated and then displayed in the open dialog box.

**Note:** If the boundary line of the measured area crosses itself, it turns red, and a dialog box is displayed informing that the polygon is invalid.

**Note:** Calculation time depends on the size of the selected region and the sample interval.
8. If you want to change the measurement units of the area or perimeter, select the required units from the drop-down lists.

**Note:** If you want to measure another region, you must click the Terrain Area command again and follow the procedure described above.
4.5 3D Plane Area Tool:

The 3D Plane Area tool enables you to measure the area of a polygon on a 3D plane for instance: surface area of a wall of a building.

To measure the area of a 3D plane:

1. On the Analysis tab, in the Measure group, click 3D Plane Area.

2. In the 3D Window, click any point in the terrain or on an object to define the start point of the measurement. A white line extends from the start point.

3. Drag the cursor to the next point in the required polygon and click again.

4. Repeat step 3 as many times as necessary to set the required area for measurement. A minimum of three points must be selected. Right-click to finish.

Note: The polygon turns red if an intersecting line is drawn. The message bar displays the polygon’s area and perimeter. If an invalid polygon was drawn, only the perimeter is displayed.

5. If you want to obtain measurements of other 3D planes, with the 3D Plane Area tool selected, repeat steps 2-4.
4.6 Contour Map Tool:

The Contour Map tool creates a topographic map that portrays differences in terrain elevation by connecting points of equal elevation with contour lines or by coloring terrain according to varying altitudes.

The contour palettes and/or contour lines can be applied to a specified rectangular area, or to the entire terrain. After the contour map has been created, a contour map object is added to the Project Tree.

To use the Contour Map tool:

1. On the Analysis tab, in the Terrain Analyze group, click Contour Map, and select one of the following options to indicate differences in terrain elevation:
   - Contour Colors - Apply different colors from a contour palette to each elevation level.
   - Contour Lines - Connect points of equal elevation with contour lines.
   - Contour Colors and Lines - Display both contour lines and contour colors.

2. In the Appearance section, in the Colorized Terrain Palette field, select a contour palette from the drop-down list.

3. In the Appearance section, in the Contour Lines Color field, click Edit and select a contour line color.

4. In the Appearance section, in the Coverage Area field, select the coverage of the contour map:
   - Rectangle - A designated rectangular area.
   - Entire Terrain - The entire terrain.

5. If you set the Coverage Area field to Entire Terrain, skip to step 7.

6. If you set the Coverage Area field to Rectangle, do the following:
   a. Place the cursor in the 3D Window, and click to add the first corner.
   b. Click a second time to add the opposite corner and complete the rectangle.

7. Continue to edit the contour map’s parameters, or close the property sheet to finish the operation.
8. If you want to display a map legend that indicates which color represents each elevation value, right-click the contour map, and select Show Legend from the shortcut menu.

**Note:** After the contour map object has been created and set to display the contour lines, automatic tool tips are added to the contour lines. When the cursor is placed, in the 3D Window, above a contour line, a tool tip appears displaying the height value of the specific line.
4.7 Slope Map Tool:

The Slope Map tool creates a slope map on the terrain that can show degree (steepness) and/or aspect (direction). The terrain is colored according to degree of slope, and arrows display the direction of the slope.

The color map and arrows can be applied to a specified rectangular area or to the entire terrain. After the slope map has been created, a slope map object is added to the Project Tree.

To use the Slope Map tool:

1. On the Analysis tab, in the Terrain Analyze group, click Slope Map, and select one of the following options:
   - **Slope Color Map** - Apply palette colors to the terrain according to degree of slope.
   - **Slope Directions** - Display on terrain arrows indicating the direction of the slope.
   - **Slope Color Map with Directions** - Display both slope colors and arrows indicating slope direction.

2. In the Slope Analysis property sheet, in the Appearance section, in the Coverage Area field, select the coverage of the contour map:
   - **Rectangle** - A designated rectangular area.
   - **Entire Terrain** - The entire terrain.

3. If you set the Coverage Area field to Entire Terrain, skip to step 5.

4. If you set the Coverage Area field to Rectangle, do the following:
   - Place the cursor in the 3D Window, and click use to add the first corner.
   - Click a second time to add the opposite corner and complete the rectangle.

5. Continue to edit the slope map’s parameters, or close the property sheet to finish the operation.

6. If you want to display the map’s legend indicating which color represents each slope range, right-click the slope map, and select **Show Legend** from the shortcut menu.
4.8 Flood Analysis Tool:

The Flood tool assesses the land area covered by water in different water flooding scenarios. The result of the flood analysis process is a set of polygons showing the flooded areas.

To use the Flood tool:

1. On the Analysis tab, in the Terrain Analyze group, click Flood.

2. In the 3D Window, click a point to mark the center of the circular area to be analyzed.

3. In the property sheet, in the Sample Interval field, enter the desired distance between sample points.

4. In the property sheet, in the Scenario Type field, select a scenario:
   - **Single Instance** - Water level rises once (initial water level set by user).
   - **Continuous Rise** - Water level rising at a constant rate over a certain period of time (rate of rise and rise interval set by user).

5. If you selected Single Instance in step 4, in the Water Level Rise field, enter the initial water elevation in meters.
6. If you selected Continuous Rise in step 4, set the following parameters in the property sheet:

- Water Rise Rate
- Start Time
- End Time
- Time Sample Interval

7. Drag the mouse to set the required radius size and click again.

Note: If the Sample Interval (See below in property sheet) is smaller than necessary for an accurate assessment, a dialog box is displayed asking if you want to increase the Sample Interval to a recommended value. Click Yes to increase the size, or No to keep the sample size as is.

The result of the flood analysis process is a set of polygons showing the flooded areas.
4.9 Volume Analysis Tool:

The Volume Analysis tool analyzes the amount of terrain removed or added by selected Modify Terrain objects.

Using the Volume Analysis Tool:

1. On the Analysis tab, in the Terrain Analyze group, click Volume. The Volume Analysis dialog box is displayed.

![Volume Analysis Tool](image)

**Fig-9: Volume Analysis Tool**

2. Select the check boxes of the Modify Terrain objects you want to analyze, and click Calculate.
4.10 Terrain Profile Tool:

The Terrain Profile tool displays the terrain elevation profile along a path, and related information on this profile such as maximum and minimum elevation values and slopes.

![Terrain Profile Tool](image)

Fig-11: Terrain Profile Tool

To use Terrain Profile Tool:

1. On the Analysis tab, in the Terrain Analyze group, click Terrain Profile.

2. Click points on the terrain to mark the path to be analyzed. Right-click to indicate the last point in the point series.

A Terrain Profile dialog box opens, displaying the terrain elevation profile between the selected points. There are five operation modes for the mouse within the profile graph:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in</td>
<td>Zooms in on a specific part of the graph by left clicking on it.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Zooms out of the graph by left clicking on it.</td>
</tr>
<tr>
<td>Pan Results</td>
<td>Scroll the graph in the desired direction.</td>
</tr>
<tr>
<td>Jump to Sample Point</td>
<td>Click on the graph to jump the camera in the 3D Window to view the selected sample.</td>
</tr>
<tr>
<td>Sample Point Information</td>
<td>Click on a specific sample in the graph to get more information about it. This information (displayed in light blue color) shows the sample elevation, coordinate and slope value.</td>
</tr>
</tbody>
</table>
In addition, there are three display options:

| Show Key Points Information | Display elevation and coordinate information about key points. This information includes the X and Y coordinates and elevation value. |
| Show Min/Max Points          | Display samples that have either maximum elevation or minimum elevation in yellow. |
| Show Min/Max Slope Points    | Display samples that have either maximum positive or maximum negative slope values in green. |

3. If you want to force results that are more accurate, set the sample size (calculation time is longer).
   a. Click Advanced Setting. The Advanced dialog box is displayed.
   b. Enter the Sample Size.

**Note:** Do not set a sample size smaller than the terrain elevation resolution, as determined by the MPT database, this causes the calculation time needed to build the elevation profile graph to increase with no increase in accuracy.

4. If you want to save the terrain profile to a file, click Export Results. The resulting file is a comma-delimited text file, with each line representing a sample point or a key point.
4.11 Best Path Tool:

The Best Path tool calculates the best path between two locations on the terrain without exceeding definable climb and descent slope limits.

To use the Best Path tool:

1. On the Analysis tab, in the Terrain Analyze group, click Best Path.

2. Set the required Best Path parameters.

3. With the cursor in the 3D Window, click to define the start point for the path.

4. Click again to define the end point of the path.

5. Once the Best Path has been calculated, it displays in the 3D Window.

6. If you want to edit its parameters and recalculate it, make the required modifications in the property sheet and in the Recalculate Path click Apply.

7. If you want to move the path, click the Edit Nodes icon, on the top bar of the property sheet, and move the node point to the required location.

8. Close the property sheet to end the operation.
4.12 Slope Query Tool:

The Slope Query tool displays information about a selected location including: its coordinates, altitude, and maximum positive/maximum negative slope values in a specified radius around the selected point.

To use the Slope Query tool:

1. Set the Slope Query properties.

<table>
<thead>
<tr>
<th>Display Max slope values</th>
<th>Defines whether the maximum positive and maximum negative slope values are displayed. Choose between Never, On Click and Always.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display heading slope</td>
<td>Defines whether the heading slope value is displayed. Choose between Never, On Click and Always. The heading is the current direction of the camera.</td>
</tr>
<tr>
<td>Display coordinate info</td>
<td>Defines whether the selected coordinate information is displayed. Choose between Never, On Click and Always.</td>
</tr>
<tr>
<td>Measure Distance</td>
<td>Defines the measurement radius around the center point.</td>
</tr>
<tr>
<td>Alert slope</td>
<td>Apply colors to slope based on Alert rating levels.</td>
</tr>
<tr>
<td>Danger slope</td>
<td>Apply colors to slope based on Danger rating levels.</td>
</tr>
</tbody>
</table>

Slope Query Properties.

2. Click Start to initiate the Slope Query tool.

3. Hover over the terrain to view slope arrows showing the maximum positive and maximum negative slope angles for the selected point.

4. Left-click to recalculate slope values using a more precise method. The calculation may take a few seconds.

5. Right-click or click Stop to exit Slope Query mode.
4.13 Line of Sight Tool:

The Line of Sight Analysis tool provides a visual indication of whether specific locations in the 3D World can be seen from a selected position. This feature takes into account the observer’s viewpoint, direction of sight and distance of sight, to portray which locations can be viewed from the viewpoint, and which locations cannot be viewed. The observer and target positions can be set at any altitude above the terrain.

To use the Line of Sight Analysis tool:

1. On the Analysis tab, in the Line of Sight group, click Line of Sight.

2. In the Line of Sight Analysis property sheet, enter the following parameters:
   a. In the Analysis section, in the Sampling Interval field, enter the desired value for the sample resolution of your measurement. This value represents the distance between terrain samples for the measurement along each line. A smaller sample size is more accurate but slower to calculate.
   b. In the Observer section, in the Height field, enter the desired value for the altitude of the observer.
   c. In the Targets section, in the Height field, enter the desired value for the altitude of the target point or points.

2. Once you have set the necessary parameters, click the cursor to define your viewpoint for the observer.

3. Place the target points in the 3D Window by clicking the left mouse button. You must place at least one point in the 3D Window.

4. Right-click to finish the operation. At this point, software begins to calculate the line of sight. This process can take a few seconds.

5. Once the Line of Sight Analysis has been completed, you can edit the parameters and recalculate, or close the property sheet to finish the operation.

Once completed, a single line, or group of lines, marked on the terrain appear between the viewpoint and the end point. Target points that are visible from the observer viewpoint are colored green, whereas points that are not visible from the observer viewpoint are colored red.

**Note:** To perform another line of sight measurement, you must first close the property sheet either by clicking on the property sheet Close icon, or by clicking again the Line of Sight command on the Analysis tab.
4.14 3D Viewshed Tool:

The 3D Viewshed Analysis tool provides you with a graphical representation of the area on the terrain and on 3D models and objects that is visible from either a defined single stationary point (3D Viewshed) or from a dynamic object moving along a defined route (Dynamic 3D Viewshed).

To create a 3D viewshed:

1. On the Analysis tab, in the Line of Sight group, click 3D Viewshed, and select 3D Viewshed. The 3D Viewshed Analysis property sheet is displayed.

2. In the 3D Window, click to define your viewpoint for the 3D viewshed, and then click again to define your desired end point (defining the distance of sight).

Once completed, the viewshed appears on the terrain as a sector of a circle, where the center point is the viewpoint and the arc is the end point (marking the end of the distance of sight analysis). Within the sector, areas that are visible from the viewpoint are colored green (default color), whereas areas that are not visible from the viewpoint are colored red (default color).

Creating a Dynamic 3D Viewshed:

The Dynamic 3D Viewshed tool creates a moving 3D viewshed along a user defined path.

To use the Dynamic 3D Viewshed tool:

1. On the Analysis tab, in the Line of Sight group, click 3D Viewshed, and select Dynamic 3D Viewshed. The Dynamic 3D Viewshed dialog box is displayed.
2. Set the Dynamic 3D Viewshed properties:

<table>
<thead>
<tr>
<th>Model Type</th>
<th>Graphic representation of the dynamic object. Select one of the 3D models: Car, Humvee or Tank, Icon for a 2D image icon, or Empty for no graphic representation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed</td>
<td>Speed of the dynamic object in <strong>mph</strong> or <strong>km/h</strong>.</td>
</tr>
<tr>
<td>Loop</td>
<td>Defines whether the dynamic object stops at the end of the path or loops back to the beginning.</td>
</tr>
<tr>
<td>Viewshed Distance</td>
<td>Distance of the 3D viewshed (in meters).</td>
</tr>
<tr>
<td>Horizontal FOV</td>
<td>Horizontal field of view of the 3D viewshed.</td>
</tr>
<tr>
<td>Vertical FOV</td>
<td>Vertical field of view of the 3D viewshed.</td>
</tr>
<tr>
<td>Color Scheme</td>
<td>Select the colors that will represent the visible and non-visible areas from the viewshed.</td>
</tr>
</tbody>
</table>

3. If you want to create a dynamic 3D viewshed along a specific line, select Follow Line. In the 3D Window, click to place each of the line waypoints, and then right-click to complete the line.

4. If you want to create a dynamic 3D viewshed along all lines in a selected group or layer, click Selected Group, and then select the required group or layer from the Project Tree.

5. If you want to create a dynamic 3D viewshed along selected polyline objects in the project, copy the required objects to the clipboard and click From Clipboard.

6. If you want to edit additional parameters, open the Dynamic 3D Viewshed group in the Project Tree and edit the objects.

![Dynamic 3D Viewshed](image-url)
4.15 Viewshed Analysis Tool:

The Viewshed tool provides you with a graphical representation of the view on the terrain from either of the following:

- A defined single point
- A series of points (route)

Creating a Viewshed (from a Single Viewpoint):

1. On the Analysis tab, in the Line of Sight group, click Viewshed, and select Viewshed.
2. In the Viewshed Analysis property sheet, set the required parameters:

![Viewshed Analysis Property Sheet]

<table>
<thead>
<tr>
<th>Object Parameter</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type the description or name of the viewshed. This text appears in the Project Tree as the name of the object.</td>
</tr>
<tr>
<td>Field Of View</td>
<td>Enter a value representing the field of view (the default is 53°).</td>
</tr>
<tr>
<td>Ray Spacing</td>
<td>Terrain explorer samples several rays (lines of sight) in the area sector. Type the space between each ray (in degrees). The smaller the ray spacing, the more accurate the measurement, but the longer it takes to calculate.</td>
</tr>
<tr>
<td>Max. Sample Interval</td>
<td>Enter the desired value for the sample resolution of your measurement, this value represents the distance between terrain samples for the measurement along each ray. A smaller sample size is more accurate but slower to calculate.</td>
</tr>
<tr>
<td>Save Results</td>
<td>Select Yes to create a group in the Project Tree under which the measurement results are saved.</td>
</tr>
<tr>
<td>Target Altitude</td>
<td>Enter the required value for the target height.</td>
</tr>
<tr>
<td>Viewer Position</td>
<td></td>
</tr>
<tr>
<td>Altitude</td>
<td>Enter the altitude above the ground for the viewer location.</td>
</tr>
<tr>
<td>X</td>
<td>Enter the X-coordinate of the viewer location. (read-only, derived from the points selected in the 3D Window)</td>
</tr>
<tr>
<td>Y</td>
<td>Enter the Y-coordinate of the viewer location. (read-only, derived from the points selected in the 3D Window)</td>
</tr>
<tr>
<td>Direction</td>
<td>Enter the horizontal angle of the camera when viewing the viewer location. (read-only, derived from the points selected in the 3D Window)</td>
</tr>
<tr>
<td>Distance</td>
<td>Distance of the viewshed (in meters). (read-only, derived from the points selected in the 3D Window)</td>
</tr>
<tr>
<td>Time Span</td>
<td></td>
</tr>
<tr>
<td>Start Time</td>
<td>Click Edit and select the date and time when the viewshed should start being visible.</td>
</tr>
<tr>
<td>End Time</td>
<td>Click Edit and select the date and time when the viewshed should stop being visible.</td>
</tr>
</tbody>
</table>
3. In the 3D Window, click to define your viewpoint for the measurement, and then click again to define your desired end point (defining the distance of sight). The created group is locked, and appears as a Viewshed icon in the Project Tree.

Once completed, the viewshed appears on the terrain as a sector of a circle, where the center point is the viewpoint and the arc is the end point (marking the end of the distance of sight). Within the sector, areas that are visible from the viewpoint are colored green, whereas areas that are not visible from the viewpoint are colored red.

Creating a Viewshed on Route:

There are three options for displaying the calculated route viewshed:

- Individual viewshed results for each selected point along the route
- A series of individual viewshed results that display according to a set timespan
- A single composite viewshed showing visible area from any of the route’s waypoints

**Note:** When calculating the viewshed from a route, the field of view is automatically set to 360°.

To create a viewshed on route:

1. On the Analysis tab, in the Line of Sight group, click Viewshed, and select how to display the viewshed:

   - Viewshed on Route
   - Timespan Viewshed on Route
   - Cumulative Viewshed on Route

The Viewshed on Route property sheet is displayed.
2. In the Viewshed Analysis property sheet, set the required parameters:

   a. TerraExplorer samples several rays (lines of sight) in the area sector. In the Settings section, in the Ray Spacing field, type the space between each ray (in degrees). The smaller the ray spacing, the more accurate the measurement, but the longer it takes to calculate.

   b. In the Max. Sample Interval field, enter the desired value for the sample resolution of your measurement. This value represents the distance between terrain samples for the measurement along each ray. A smaller sample size is more accurate but slower to calculate.

   c. In the Distance field, type the length of the radius of sight from each of the route’s waypoints.

   d. In the Viewer Height field, enter your desired value for the altitude of your viewpoints.

   e. The Analysis Type field is derived from the Viewshed on Route type that you selected from the ribbon. If you want to change the analysis type, click and select the required type.

   f. In the Timespan section, click Edit and select a Start Time and End Time for the display of the Viewshed results. The timespan is split evenly between the individual viewshed results. Each individual viewshed result is displayed when the current system time falls within its calculated time span.

   g. In the Waypoints section, type the distance between sample route waypoints.

3. Once you have set the necessary parameters, click in the 3D Window to define the first waypoint on your route. Drag and click the mouse to define the end point of the route. Right-click to finish.

4. Click Calculate. The created Viewshed on Route locked group appears in the Project Tree.

5. Once you establish the end point, all of the parameters become read-only. At this point, TerraExplorer Pro begins to calculate the viewshed measurement. This process can take some time if the route has a considerable number of waypoints.

The viewshed representation depends on the viewshed type selected:

- **Viewshed on Route** – Individual circles display for each of the route’s waypoints. Each circle has a radius equal to the Distance of Sight. Within each circle, areas that are visible from the respective waypoint are colored green, whereas areas that are not visible from the waypoint are colored red.
- **Timespan Viewshed on Route** - A series of individual viewshed results display according to the set timespan. The timespan defined is divided evenly between the waypoints, with each viewshed result displaying when the current system time falls within its segment of the timespan.

- **Cumulative Viewshed on Route** – A single oval shape displays; the longer the route, the more oval and less round the viewshed representation appears. Areas that are visible from any of the waypoints are colored green, whereas areas that are not visible from any of the route’s waypoints are colored red.

![Viewshed](image1)

![Viewshed on Route](image2)

### 4.16 Threat Dome Tool:

The threat dome tool analyzes and displays the volume that is visible from a given point on the terrain. You can set various parameters, like the Scan field and elevation angle, and analyze different areas for visibility.

To use the threat dome tool:

1. On the Analysis tab, in the Terrain Analyze group, click Threat Dome.
2. Set the required threat dome parameters.
3. With the cursor in the 3D Window, click the mouse to define the pivot point for the threat dome.
4. Once the threat dome has been created, continue editing its parameters or close the property sheet to finish the operation.
4.17 Selection Shadow Tool:

To display a shadow for selected objects:
1. In the 3D Window, set the time, date and time zone using the Date and Time controls.
2. Select the objects from which you want to cast a shadow.
3. On the Analysis tab, in the Shadow group, click the arrow next to Selection Shadow, and select Show Selection Shadow.
4. If you want to clear a Selection Shadow, click the arrow next to Selection Shadow, and select Hide Selection Shadow.
5. If you want to recast the shadow from the previously selected object to a currently selected object, click the arrow next to Selection Shadow, and select Update Selection.
4.18 Imagery Comparison Tool:
The Imagery Comparison tool helps you detect the changes between two images of the same location or between an imagery layer and the base terrain by allowing you to dynamically compare the 3D view with a particular imagery layer.

To use the Imagery Comparison tool:

Note: The tool selects the first visible layer. If you want to compare a specific imagery layer to the base terrain, make only that layer visible.

1. Zoom in on an area with a visible imagery layer.

2. On the Analysis tab, in the Comparison group, click Imagery Comparison. The Imagery Comparison dialog box is displayed.

3. Use the following controls:

- **Mode selection** – Selects the slider control mode. Choose between four clipping modes (right-left, left-right, top-bottom and bottom-top) and Transparency mode.

- **Slider control** – Defines the clipping or transparency level extent. Slide the slider all the way to the right to completely reveal the top layer, and all the way to the left to entirely clip it. As the slider moves between these extremes, the top layer is gradually clipped or opacity decreased to reveal the bottom layer or terrain.

- **Auto button** - Automatically loop the slider value between 0-100% to dynamically change the top layer clipping or transparency level.

4. Pan and zoom the 3D view to your area of interest. The tool automatically updates the imagery layer clipping according to the current view.
5. DRAW:

5.1 Select Tool:
Select tool helps you to edit objects drawn using Draw Tool.
To use Select Tool:
1. On Draw tab, in Select group, click Select.
2. In the 3D window, left click on the object to select it.
3. Edit the object using properties sheet.

5.2 Delete Tool:
Delete tool helps you to delete the selected objects.
To use Delete tool:
1. On Draw tab, in Select group, click Delete.
2. In 3D window, left click on the object you want to delete.
3. In the message window, click OK button to delete the selected object.
5.3 Marker Tool:
This tool will help you to place Text marker on 3D terrain.
To use Marker Tool:
1. On Draw tab, in Draw group, click Marker.
2. In marker properties Dialog Box, type the text you want to display.
3. Click over the 3D terrain to display the text.

5.4 Drawing Tool:
This tool will help you to draw freehand lines on the terrain.
To use Drawing Tool:
1. On Draw tab, in Draw group, click Drawing.
2. In drawing properties Dialog Box, select the color.
3. Click and hold the mouse button and move the cursor on the terrain.
5.5 Urban Design:

This tool allows you to create an urban scenario with its own roads, junctions and traffic lights. Urban Design Tool has the following three Drawing objects:

a. Road Builder
b. Junction
c. Traffic Light

To use Road Builder Tool:
1. On Draw tab, in Draw group, click Urban Design.
2. Click Road Builder tool.
3. In the Properties Sheet, set the object parameters.

[Images: Road Builder-Properties Sheet, Drawing Road using Road Builder Tool]
To use Junction Tool:

1. On Draw tab, in Draw group, click Urban Design.
2. Click Junction.
3. In the Properties Sheet, select one of the junction types.

To use Traffic Light object:

1. On Draw tab, in Draw group, click Urban Design.
2. Click Traffic Lights.
3. In the Properties Sheet, select one of the traffic light types.
5.6 Creating Text Label:

To create a new text label:

1. On the Draw tab, in the Advanced Editing group, click Text. The Enter Label Text dialog box is displayed.

2. Type the text in the Enter Label Text dialog box. You must enter a text and click OK before you can place the object in the 3D World.

3. Place the label in the 3D Window by clicking in the desired location.

4. Continue to edit the label’s parameters, or close the property sheet to finish the operation.
5.7 Creating Image Label:

To create a new Image Label:

1. On Draw tab, in Advanced Editing group, click Image. The Browse for Image dialog box is displayed.

2. Type or browse a path to a BMP, JPEG, GIF, PNG or ICO file to load as an image. You must set an image file before you can place the object in the 3D World.

3. Place the label in the 3D World by clicking in the desired location.

4. Continue to edit the label’s parameters, or close the property sheet to finish the operation.
5.8 Creating a Polyline:

To create a new Polyline:


2. Set the parameters of the polyline, like color, width etc.

3. Place the polyline points in the 3D Window by clicking in the desired locations. You must place at least two points.

4. Finish the polyline insertion by right-clicking.

5. Continue to edit the polyline’s parameters, or close the property sheet to finish the operation.
5.9 Creating a Polygon:

To create a new polygon:

1. On the Draw tab, in the Advanced Editing group, click Polygon. The Polygon property sheet opens.

2. Set the parameters of the polygon, like color, opacity etc.

3. Place the polygon points in the 3D Window by clicking in the desired locations. You must place at least three points.

4. Finish the polygon creation by right-clicking.

5. Continue to edit the polyline’s parameters, or close the property sheet to finish the operation.

Creating a Polyline
5.10 Creating 2D Shape:

To create a 2D shape:

1. On the Draw tab, in the Advanced Editing group, click 2D Shape. The Shape’s property sheet opens.

2. Set the parameters of the 2D shape like number of sides, line width, color, radius etc.

3. Place the shape’s points in the 3D Window:
   - Rectangle - Click to add the first corner, and then click a second time to add the opposite corner and complete the rectangle.
   - Regular Polygon –
     i. Click to define the center (pivot point) of the regular polygon.
ii. Drag the mouse to set its radius.

iii. Click a second time to set the regular polygon.

- Circle –
  i. Click to define the center of the circle.
  ii. Drag the mouse to set the radius of the circle.
  iii. Click again to set the radius and complete the circle.

- Ellipse –
  i. Click to define the center of the ellipse.
  ii. Drag the mouse in the X direction to define the first radius. Drag the mouse in the Y direction to define the second radius.
  iii. Click again to complete the ellipse.

- Arc –
  i. Click to define the center of the ellipse from which the arc is formed.
  ii. Drag the mouse in the X direction to define the first radius. Drag the mouse in the Y direction to define the second radius.
  iii. Click again to complete the arc.

- 2D Arrow –
  i. Click to define the pivot point of the 2D arrow.
  ii. Drag the mouse to set its size and direction.
  iii. Click a second time to set the 2D arrow.

4. Edit the shape’s parameters in the open property sheet or in the 3D Window. Close the property sheet to finish the operation.

5.11 3D Model:

To add a new 3D model:

1. On the Draw tab, in the Advanced Editing group, click 3D Model. Click on 3D Model option from the dropdown list.
2. Browse for 3D model window opens. Browse for the file and click on Open button.
3. Click in terrain to add 3D model.
4. In Static model Properties sheet, set the scale to 1 and close the Properties sheet.

To create a 3D Building:

1. On the Draw tab, in the Advanced Editing group, click 3D Model and then click on Building option from the dropdown list.
2. With the cursor in the 3D Window, click the mouse to add the first point of the roof.
3. Click again to add additional points of the roof’s polygon until you have marked the entire shape. You must place at least three points to define the roof.

   **Note:** When creating a building, the lines of the roof polygon should not overlap each other. This may result in an irregular object.

   It is recommended to keep the number of roof points to the minimum required to define the shape. Adding unnecessary points may adversely affect performance.

4. Right-click to finish the roof polygon.
5. Drag the mouse pointer to the base of the building and right-click to finish the operation.

6. Enter the roof height of the building under Geometry in the Building property sheet.

7. Continue to edit the building’s parameters and shape, or close the property sheet to finish the operation.

**Defining Roof and Wall Fill Types for a 3D Building:**

For each of a building’s sidewalls and its roof, you can assign a fill that is a single color, a texture from a file, or a texture from the terrain pattern. A different fill type can be assigned to each face of the building.

To change a building’s fill type:

1. In the Texture section of the property sheet, in the Selected Face field, select the required surface.
2. In the Face Fill Type field, select the required fill type.

   **Note:** You can select the Terrain Texture option for sidewalls and for roof.

3. For each surface for which you select Terrain Texture as the fill type, assign the Face Terrain Texture parameter.

4. For each surface for which you select Single Color as the fill type, select a Face Color.

5. For each surface for which you select Image File Texture as the fill type, browse to the required Face Texture File.

**Modifying the Building Geometry and Position:**

After creating the building’s initial geometry, you can still modify it by selecting one of the top bar tools and editing the building shape in the 3D Window.
Creating Angular Roof:

1. After creating the building geometry in the Appearance section of the property sheet, in the Rooftop Style field, select Angular Roof.

2. On the top bar of the property sheet, click **Edit Angular Roof**.

3. In the 3D Window, select the angular roof points and drag them to the top-most position of the roof. The angular roof points are located between the connecting lines (cyan) and the rooftop frame (purple). The points of the angular roof shape should not overlap each other.

4. In the Geometry section of the property sheet, set the rooftop delta height.
5.12 3D Shape:

To create a new 3D shape:

1. On the Draw tab, in the Advanced Editing group, click 3D Shape. The Shape’s property sheet opens.
2. Set the parameters of the 2D shape like number of sides, line width, color, radius etc.
3. Place the shape’s points in the 3D Window:

   - **Box:**
     - To draw a Box:
     1. Click the mouse to define the first corner of the box.
2. Drag the cursor to set the base of the box.
3. Once the base is set, click again to complete it.
4. Move the mouse up or down to define the height of the box.
5. Once the height is set, click again to complete the box.

- **Cylinder:**

To draw a cylinder:
1. Click the mouse to define the center point of the cylinder’s base.
2. Drag the cursor to set the base of the cylinder.
3. Once the base is set, click again to complete it.
4. Move the mouse up or down to define the height of the cylinder.
5. Once the height is set, click again to complete the cylinder.

- **Sphere:**

To draw a sphere:

Note: In the property sheet, you can choose to create a full sphere or just an upper or lower half of a sphere. When using half a sphere you can create it with or without a base.
1. Click the mouse to define the bottom center (pivot point) of the sphere.
2. Drag the cursor to define the radius of the sphere.
3. Once the radius is set, click again to complete the sphere.

- **Cone:**

To draw a cone:
1. Click the mouse to define the center point of the base circle.
2. Drag the cursor to define the radius of the base circle.
3. Once the base circle is set, click again to complete it.
4. Move the mouse up or down to define the height of the cone.
5. Once the height is set, click again to complete the cone.

- **Pyramid:**

To draw a pyramid:
1. Click the mouse to define the first base point.
2. Drag the cursor to set the base of the pyramid.
3. Once the base is set, click again to complete it.
4. Move the mouse up or down to define the height of the pyramid.
5. Once the height is set, click again to complete the pyramid.

- **3D Arrow:**

To draw a 3D arrow:
1. Click the mouse to define the pivot point of the 3D arrow.
2. Drag the cursor to set the length of the 3D arrow.
3. Once the base of the arrow is set, click again to complete it.
4. Move the mouse up or down to define the height of the arrow.
5. Once the height is set, click again to complete the 3D arrow.

- **3D Polygon:**
  To draw a 3D polygon:
  1. Click the mouse to define the first point of the 3D polygon.
  2. Drag the cursor to the second point. Click again to set the second point.
  3. Repeat the above step as many times as you like, until you have created your desired shape for the polygon. (The polygon still appears two-dimensional at this point.)

  **Note:** When creating a 3D Polygon, the lines of the base polygon should not overlap each other. This may result in an irregular object.
  4. Once the shape is established, click the right mouse button to complete it.
  5. Move the mouse up or down to define the height of the 3D polygon.
  6. Once the height is set, click again to complete the 3D polygon.

4. Edit the shape’s parameters in the 3D Window or using the property sheet. Close the property sheet to finish the operation.

6. **NAVIGATION:**

6.1 Navigate in Drag Mode:

To navigate in the drag mode:

1. Click and hold the mouse button on a location in the terrain.

2. Drag the mouse to the sides forward, and backward. The terrain location on which you clicked is dragged along with the cursor.

6.2 Navigate in Slide Mode:
To navigate in the slide mode:

1. Click and hold the mouse button on a location in the terrain.
2. Drag the mouse to slide forward, backward and to the sides.

6.3 Navigate in Turn and Tilt Mode:

To navigate in the Turn & Tilt mode:

1. Click on the 3D Window to change the plane or the camera direction and tilt angles.
2. Click and drag the mouse to other areas and even outside the 3D Window to change the mouse operations.

6.4 3D Mode:

3D Modes determine how the terrain should be depicted in the 3D Window, as a 3D model, a flat 2D surface, or as a 2D model facing North.

To set navigation modes:

- On the Navigation tab, in the 3D Mode group, click one of the following commands:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D Mode</td>
<td><img src="icon" alt="3D" /></td>
<td>Allows full 3D navigation.</td>
</tr>
<tr>
<td>2D Mode</td>
<td><img src="icon" alt="2D" /></td>
<td>Forces the camera to always look straight down.</td>
</tr>
<tr>
<td>2D Mode Face North</td>
<td><img src="icon" alt="2D" /></td>
<td>Forces the camera to always look straight down and North.</td>
</tr>
</tbody>
</table>

6.5 GPS Tracking:

To use the GPS Tracking tool:

1. On the Navigation tab, in the Navigation Aid group, click GPS Tracking.
2. Enter the following information:
3. Click **Connect** to connect to the GPS stream. If you want to disconnect, click **Disconnect**.

6.6 Target:

The Target tool continuously tracks the distance and direction to a specific target.

To use the Target tool:

1. On the Navigation tab, in the Navigation Aid group, click Target. The Target dialog box
2. Enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Set Mode</td>
<td>Select either:</td>
</tr>
<tr>
<td></td>
<td>• Numeric Entry</td>
</tr>
<tr>
<td></td>
<td>• Manual Selection</td>
</tr>
<tr>
<td>Target Mark Type</td>
<td>Select the Target Mark Type around the target point.</td>
</tr>
<tr>
<td>Target Mark Size</td>
<td>Enter the Target Mark Size of the target-marking object (if available).</td>
</tr>
<tr>
<td>Display Units</td>
<td>Select the display units to be used for distance/height information display.</td>
</tr>
<tr>
<td>Show Direction Arrow</td>
<td>Select Yes if you want to display the direction-to-target arrow.</td>
</tr>
<tr>
<td>Show MGRS</td>
<td>Select Yes if you want to display the coordinates in MGRS system.</td>
</tr>
<tr>
<td>Target X, Target Y, Target H</td>
<td>If you selected Numeric Entry, enter the target's X, Y and Height coordinates.</td>
</tr>
</tbody>
</table>

3. If you are using Manual Selection as the Target-Set-Mode, click on the terrain or on any object in the 3D Window.

4. The tool displays the Camera Location, Cursor Location, Target Location and Distance from Target values according to the selected units.

5. To reset this tool, click the Reset button.

6.7 Multiple Co-ordinate Systems Tool:

To use the Multiple Coordinate Systems tool:

1. On the Navigation tab, in the Navigation Aid group, click Multiple Coord Sys. The Multiple Coord Sys dialog box opens.
2. In the Lat Long section, select the Latitude display mode:
   - Decimal Degrees
   - Degrees, Decimal Minutes
   - Degrees, Minutes, Seconds

3. If you want to add another coordinate system, in one of the Not Assigned sections, click Choose CS. The Coordinate System dialog box opens. Enter the required information.

4. If you want to jump to a location based on the assigned coordinate system, in the Lat-Long section, type the X and Y coordinates of the desired location and click **Jump To**.

6.8 Look Around Tool:

To use the Look Around tool:

1. On the Navigation tab, in the Navigation Aid group, click Look Around. The Look Around controls are displayed.

2. Move the slider to adjust the zoom.

3. Click Reset to restore the original zoom.

7. **View**:

7.1 Layout:

To select a standard layout:

- On the View tab, in the Layout group, click one of the following layout options:
7.2 Hide Terrain:

You can hide the terrain texture (the terrain appears as a black image).

To hide the terrain:

- On the View tab, in the Terrain Imagery group, click Hide Terrain.

7.3 Units:

To change units:

- On the View tab, in the Units group, select the speed, altitude, and coordinate units:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lat-Long Coordinates</td>
<td></td>
</tr>
<tr>
<td>Decimal</td>
<td>Presents coordinate values in a decimal degrees format. This option is only</td>
</tr>
<tr>
<td></td>
<td>available when the terrain is defined in the Lat/Long coordinate system.</td>
</tr>
<tr>
<td>Degrees; Minutes; Seconds</td>
<td>Presents coordinate values in a degrees, minutes and seconds format. This</td>
</tr>
<tr>
<td></td>
<td>option is only available when the terrain is defined in the Lat/Long</td>
</tr>
<tr>
<td></td>
<td>coordinate system.</td>
</tr>
<tr>
<td>Speed</td>
<td></td>
</tr>
<tr>
<td>Km/h</td>
<td>Sets the display units for Speed to kilometers per hour.</td>
</tr>
<tr>
<td>Mph</td>
<td>Sets the display units for speed to miles per hour.</td>
</tr>
<tr>
<td>Knots</td>
<td>Sets the display units for speed to knots.</td>
</tr>
<tr>
<td>Altitude Units</td>
<td></td>
</tr>
<tr>
<td>Above Ground Level (AGL)</td>
<td>Displays altitude values as meters or feet above the ground level in the</td>
</tr>
<tr>
<td></td>
<td>selected coordinates.</td>
</tr>
<tr>
<td>Absolute Values</td>
<td>Displays altitude values as meters or feet above the terrain database</td>
</tr>
<tr>
<td></td>
<td>vertical datum base ellipsoid.</td>
</tr>
</tbody>
</table>

7.4 Screen Overlays:

To display/hide a screen overlay element:

- On the View tab, in the Screen Overlay group, select/clear the required element’s check box.

7.4.1 Navigation Controls:
The navigation controls and virtual joystick enable you to rotate, tilt or zoom in or out of the terrain, free-fly in the 3D World and change the camera tilt and plane direction.

To navigate in the 3D Window using the navigation controls:

- Click the navigation controls to rotate, tilt or zoom in or out of the terrain.

<table>
<thead>
<tr>
<th>Navigation Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tilt Slider</td>
<td>Move the Tilt slider to change the plane tilt.</td>
</tr>
<tr>
<td>North Indicator</td>
<td>Click the N indicator in the compass ring to turn the plane to face north.</td>
</tr>
<tr>
<td>Compass Ring</td>
<td>Click and turn the compass ring to change the plane direction.</td>
</tr>
<tr>
<td>Joystick</td>
<td>The virtual joystick enables you to free-fly in the 3D World in an intuitive manner, similar to real-life flying. With the virtual joystick, you can fly backward, forward and sideways. You can also perform the same action by using the up/down and left/right arrows around the joystick.</td>
</tr>
<tr>
<td>Zoom Slider</td>
<td>Click and drag the elevation slider to zoom in and out. You can also click the globe, country, state, city and street levels.</td>
</tr>
</tbody>
</table>

7.4.2 Center Sign:
The Center Sign displays the 3D Window center point.

7.4.3 Status Bar:
The status bar displays:
- The longitude, latitude, altitude, and direction of the plane/camera. Clicking to the right of the status bar opens the Flight Control Panel.
**Flight Control Panel:**

From the Flight Control Panel, you can modify longitude, latitude, altitude and direction values by entering precise values in the appropriate digital indicator boxes.

![Jump to Location](image.png)

To use the Flight Control Panel:

1. Click on the bottom right of the 3D Window to display the panel, and enter the required values.

    | Field    | Description                                                                 |
    |----------|-----------------------------------------------------------------------------|
    | Longitude| Enter the new location’s East-West values.                                  |
    | Latitude | Enter the new location’s North-South values.                                |
    | Altitude | Enter the required altitude value.                                          |
    | Direction| Enter the required direction angles of the plane and the camera.            |

2. Click OK.

**7.4.4 Scale Bar:**

The scale bar shows the ratio of a distance in the 3D virtual World to the corresponding distance in the actual world.

![Scale Bar](image.png)

**7.4.5 Date & Time Slider:**

The Date and Time Slider enables you to modify the current date and time so you can view each area of terrain in the date and time range that you require. If the sun is used as the project’s light source, the displayed light on the terrain corresponds to the sunlight there is on the terrain at the hour and date indicated by the blue marker on the slider. The objects displayed on the terrain at each selected time
correspond to the timespans that were set for these objects. The timespan for an object or group can be set in its property sheet.

![Date & Time Slider](image)

7.4.6 Graphic HUD:

The graphic Head Up Display features the following elements:

<table>
<thead>
<tr>
<th>Elements</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leftmost Number</td>
<td>Displays the speed of the plane in the selected units.</td>
</tr>
<tr>
<td>Rightmost Number</td>
<td>Displays the altitude of the plane in the selected units.</td>
</tr>
<tr>
<td>Center Sign</td>
<td>Indicates the center of the view.</td>
</tr>
<tr>
<td>Top Bar</td>
<td>Displays the direction of the plane. The triangle points in the plane’s direction.</td>
</tr>
<tr>
<td>Main Bar</td>
<td>The columns on both sides display the tilt level and the roll level, for the camera.</td>
</tr>
</tbody>
</table>

7.5 Field of View:

The field of view is the size of the camera’s viewing angle, or the zoom level of the camera. The field of view ranges from 15 to 90 degrees, with 53 degrees set as the default.

To set the camera’s field of view:
7.6 Environmental Effects:

You can turn on and off certain animated environmental effects. A cloud cover can be displayed over the entire terrain, and animated water can be displayed on sea and ocean terrain.

To show animated clouds:

- On the View tab, in the Environmental Effects group, select **Show Clouds**.

To show animated water:

- On the View tab, in the Environmental Effects group, select **Show Water**.